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Abstract

The aim of this system is to make a smart Automatic Rain Shade for Different

Ambient Conditions which can reduce human effort due to its functionality and can

target the market due to its unique design, is really important in modern society at risk of

rainfall and wind without coverage in place. The purpose of this project is to make such

an rain shed that is really sensitive in the incidences of rain and sunlight at domestic and

market level. Specifically, in summer season the floor of open areas gets so warm due to

sun light that makes difficulty for working. This system covers the entire place during

the rain and sunlight. This shed operates with the help of rain sensors. The opening and

closing of rain shed is being controlled through a motor automatically and manually.

Motor can give a quick and instant response to the shaft so that shaft can play a major

role of power transmission for opening and closing of shed. Motor provides required rpm

to the shaft. Whenever rain come and after rain sensor detect the rain then the system will

work automatically. Arduino sends signal further to the motor so that motor may activate

and deliver required rpm to the coupling shaft. This project is a cost-effective way of

providing automated controlled shade from high intensity sunlight and rain. So, the

problems of open and vast areas can be solved by using such types of automated rain

shed.



v

TABLE OF CONTENTS

Letter of transmittal i
Declaration ii
Acknowledgement iii
Abstract iv

CHAPTER-1 INTRODUCTION

1.1 Introduction 01
1.2 Objectives 02
1.3 Organization of Book 02

CHAPTER-2 LITERATURE REVIEW

2.1 Introduction 03
2.2 Literature Review 03
2.3 Summary 04

CHAPTER-3 STRUCTURE

3.1 Block Diagram 5
3.2 Circuit Diagram 5
3.3 Components List 6

CHAPTER-4 HARDWARE ANALYSIS

4.1 Arduino Pro Mini 07
4.2 Voltage Regulator IC 09
4.3 SMPS 10
4.4 Motor Driver IC 15
4.5 Motor Driver 17
4.6 DC Gear Motor 19
4.7 Motor Pully 20
4.8 Rain Sensor 21
4.9 Bearing 23



vi

4.10 Capacitor 25
4.11 Resistor 26
4.12 Arduino IDE 27
4.13 Proteus Software 31

CHAPTER-5 METHODOLOGY

5.1 Our Methodology of the Project 33
5.2 Complete Project Image 33
5.3 Working Principle 34

CHAPTER-6 RESUTL AND DISCUSSION

6.1 Discussion 35
6.2 Result 35
6.3 Advantages 37
6.4 Application 37
6.5 Limitation 37

CHAPTER-7 CONCLUSION

7.1 Conclusion 38
7.2 Future Scope of Work 38

REFERENCE 40

APPENDIX 42



vii

LIST OF FIGURES

FIGURE NO FIGURE NAME PAGE NO

3.1 Block Diagram 5

3.2 Circuit Diagram 6

4.1 Arduino Pro Mini 7

4.2 Arduino Pin Out 9

4.3 VOLTAGE REGULATOR 10

4.4 SMPS 10

4.5 SMPS Circuit 12

4.6 SMPS Circuit Connection 13

4.7 L293D 15

4.8 L293D Circuit Diagram 16

4.9 Motor Driver Sheld 17

4.10 Logic Diagram 18

4.11 IC Pin Out 18

4.12 Gear Motor 20

4.13 Pulley 21

4.14 Rain Sensor Pin Diagram 21

4.15 Rain Sensor Pin Description 22

4.16 Bearing 24

4.17 Capacitor 25

4.18 Smooth Capacitor 26

4.19 Resistor 27

4.20 Arduino IDE 28

4.21 Proteus Software Interface 32

5.1 Complete Prototype Picture 33

6.1 Our System in Full Open Position 35

6.2 Our System in Half Fold Position 36

6.3 Our System in Full Fold Position 36



1

CHAPTER 1

INTRODUCTION

1.1 Introduction

A rain shed is a folding canopy (overhead roof) supported by metal or wooden ribs that

is usually mounted on a wooden, metal or plastic pole. It is designed to protect a person

against sunlight and rain. rain sheds and parasols are primarily hand-held portable

devices sized for personal use. The largest hand-portable rain sheds are golf rain sheds.

rain sheds can be divided into two categories: Fully collapsible rain sheds, in which the

metal pole supporting the canopy retracts, making the rain shed small enough to fit in a

handbag and non-collapsible rain sheds, in which the support pole cannot retract and only

the canopy can be collapsed.

Generally, sun shading big rain sheds is used at beaches, swimming pools or in

courtyards, a lot of coffee shops or restaurants also use sun-shading big rain sheds on

tables and rain-shielding but also for providing a good mood of being in the surrounding.

Therefore, the big rain sheds are quite practical. For such types of purposes, an automated

rain shed is required which is equipped with modern technology. The vision is to make a

optimize structure which is of low cost that fulfills the need of the people working in

open areas. The main function of an automated rain shed is protection from sunlight. This

rain shed meets these needs by using multiple sensors and a set of DC motors to

automatically track the sun to maximize shading where it is being used. DC motor is used

for direct and Instant response of a current having single phase. The selection of DC

motor depends upon torque. It operates whenever sun rises in morning, sensors detect

light and activate the motors of rain shed which further drives the shaft to open and close

the rain shed. Now a days these types of rain sheds are also be used for car parking. The

purpose of doing this is to feel comfortable while working in open areas and to make a

design which is really reliable for domestic and industrial purposes.
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1.2 Objective:
The objectives of this project are:

a) To study about Automatic Rain Shade for Different Ambient

Conditions.

b) To Design and Fabrication of Automatic Rain Shade for Different

Ambient Conditions.

c) To test the performance of the Automatic Rain Shade for Different

Ambient Conditions system.

d) To modelling and fabricates a Automatic Rain Shade for Different

Ambient Conditions .

e) To decrease the cost of machine by application of simple mechanism.

1.3 Organization of the Book

 Chapter 1: Introduction. This chapter is all about background study, motivation,

Objectives and thesis book organization.

 Chapter 2: Literature Review- Here briefly describe about previous book review

and Summary of this chapter.

 Chapter 3: Structure- This chapter is discussed about block diagram, circuit

diagram, components of list . Here we describe our hole instrument details.

 Chapter 4 : Hardware Analysis - This chapter is discussed about our project

hardware and Software . Here we describe our hole instrument details.

 Chapter 5: Methodology– Here briefly discuss about project methodology,

working principle and our system overview.

 Chapter 6: Result and Discussion– Here briefly discuss about project discussion,

result analysis, advantages, application and our system overview.

 Chapter 7: Conclusion – This chapter is all about our thesis future

recommendation and this project conclusion.
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CHAPTER 2

LITURATURE REVIEW

2.1 Introduction
This chapter mainly reviews literature, reviews of various types of work and highlights

the importance of Design and Fabrication of Automatic Rain Shade for Different

Ambient Conditions in such situations.

2.2 Literature review:
Many researchers have recently exploited the capability of single board microprocessors

and sensors. Following section briefly describes various systems on which our work is

built upon:

A. Arduino and Water Sensor: In recent years, water sensors along with Arduino or

Raspberry Pi are used in many applications specifically related to smart irrigation. In [1]

water flow sensor along with temperature sensor and soil moisture sensors are used with

Arduino. Data collected by these sensors are sent to the interactive website by a WIFI

module attached with an Arduino. This allows user to control water pump and sprinklers

from distance which will facilitate farmer to obtain maximum quality crops. In [2] smart

drip irrigation system is proposed using Arduino, Raspberry Pi and Zigbee modules.

Arduino micro-controllers are used to receive the on/off commands from the Raspberry

Pi using Zigbee protocol. The water pump can automatically start by just sending an

email to system. In [3] Arduino and water sensors are used for measuring and monitoring

water quality for fish farming. It is used to measure temperature and pH value of water.

Collected data is sent via Bluetooth to mobile application for monitoring purpose.

B. Arduino and Temperature Sensor: Many researchers have used Arduino and

temperature sensors along with GSM, GPRS, Bluetooth and Zigbee modules for

automation of various systems. Some of the systems are as follows: “Home Weather

Station” is a mobile weather station that displays weather details on a LCD screen [4].

The outdoor station measures temperature, pressure and humidity and send it to indoor
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module for display. In [5] designed a low cost environment monitoring system using

Raspberry Pi and Arduino with Zigbee. In [6]continuous heart rate and body temperature

monitoring system is proposed using Arduino UNO and Android device.

C. Arduino and Light Dependent Resistor: Light Dependent Resistor (LDR) has used

in many applications where light has to be used or sensed for automation purpose. In [7]

used LDR as sensor and Light Emitting Diode (LED) as light source to design water

turbidity gauge. Turbidity of water is measured by passing a light source through water to

measure the intensity of light reflected. Analog data received by Arduino from LDR is

converted into digital form and the result is displayed on LCD. In [8] an intelligent street

light system is proposed. Street light not only depends on darkness but also on motion.

Street light will only turn on if its dark and motion is detected otherwise it will stay off,

thus energy is saved.

In [9] proposed origami-based automatic solar panels. Normally, solar panels are

stationary and energy absorbed is not optimum. To make sure maximum solar energy is

absorbed by solar panels rotational solar panels are proposed. LDR will obtain and

measure sun light and solar panels will automatically rotate towards maximum sun light.

Above are some of the systems that have used Arduino as microprocessor and LDR, LM

35 and water sensors individually for data collection. None of the systems have combined

all these sensors and designed a system to automatically open or close a shed or an rain

shed. This paper proposed a system that will automate shed depending upon temperature,

light and water to facilitate user needs accordingly.

2.3 Summary

From the literature discussed above, we gained a lot of knowledge and we inspired to do

this project. We were able to do it with everyone tireless work.
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CHAPTER 3

STRUCTURE

3.1 Block Diagram:
The main brain of our system is the Arduino Pro Mini. The way of whole project works is

that we take 220V AC power from the supply voltage and then feed it to a Switch Mode

Power Supply or in short SMPS module. The SMPS simply converts the 220V AC to a

pure DC of 5V. We will use this 5V DC output from the SMPS to run our controller, gear

motor and other units.

Figure 3.1: Block Diagram

3.2 Circuit Design

Arduino Pro Mini has been used as main controller for this project. With the help of

controller which the project can be controlled our system automatically. .
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Figure 3.2: Schematic Diagram

3.3 Components List:
1. Arduino Pro Mini

2. SMPS

3. Gear Motor

4. Motor Driver

5. Bearing

6. Black Paper

7. Aluminum Body

8. Pully Belt

9. Motor Pully

10. Rain Sensor

Software

1. Arduino IDE

2. Proteus
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CHAPTER 4

HARDWARE ANALYSIS

4.1 ARDUINO PRO MINI

The Arduino Pro Mini is a micro-controller board based on the ATmega168. It has 14

digital input/output pins (of which 6 can be used as PWM outputs), 6 analog inputs, an

on-board resonator, a reset button, and holes for mounting pin headers. A six pin header

can be connected to an FTDI cable to provide USB power and communication to the

board.

Figure 4.1: Arduino Pro Mini

Specification

 Micro-controller ATmega168

 Operating Voltage: 3.3V or 5V (depending on model)

 Input Voltage: 3.35 -12 V (3.3V model) or 5 - 12 V (5V model)

 Digital I/O Pins: 14 (of which 6 provide PWM output)

 Analog Input Pins: 6

 DC Current per I/O Pin: 40 mA

 Flash Memory: 16 KB (of which 2 KB used by boot loader)
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 SRAM: 1 KB

 EEPROM: 512 bytes

 Clock Speed: 8 MHz (3.3V model) or 16 MHz (5V model)

Pin Out

Each of the 14 digital pins on the Pro Mini can be used as an input or output, using pin

Mode(), digital Write(), and digital Read() functions. They operate at 3.3 or 5 volts

(depending on the model). Each pin can provide or receive a maximum of 40 mA and has

an internal pull-up resistor (disconnected by default) of 20-50 kOhms. In addition, some

pins have specialized functions:

 Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial

data. These pins are connected to the TX-0 and RX-1 pins of the six pin header.

 External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt

on a low value, a rising or falling edge, or a change in value. See the

attachInterrupt() function for details.

 PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite()

function.

 SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI

communication, which, although provided by the underlying hardware, is not

currently included in the Arduino language.

 LED: 13. There is a built-in LED connected to digital pin 13. When the pin is

HIGH value, the LED is on, when the pin is LOW, it's off.

The Pro Mini has 6 analog inputs, each of which provide 10 bits of resolution (i.e.

1024 different values). Four of them are on the headers on the edge of the board;

two (inputs 4 and 5) on holes in the interior of the board. The analog inputs

measure from ground to VCC. Additionally, some pins have specialized

functionality:
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 I2C: 4 (SDA) and 5 (SCL). Support I2C (TWI) communication using the Wire

library.

There is another pin on the board:

 Reset. Bring this line LOW to reset the micro controller. Typically used to add a

reset button to shields which block the one on the board.

See also the mapping between Arduino pins and ATmega168 ports.

Figure 4.2: Arduino Pro Mini Pin Out

4.2 VOLTAGE REGULATOR IC

Voltage sources in a circuit may have fluctuations resulting in not providing fixed voltage

outputs. A voltage regulator IC maintains the output voltage at a constant value. 7805 IC,

a member of 78xx series of fixed linear voltage regulators used to maintain such

fluctuations, is a popular voltage regulator integrated circuit (IC). The xx in 78xx

indicates the output voltage it provides. 7805 IC provides +5 volts regulated power supply

with provisions to add a heat sink.

7805 IC Rating:

 Input voltage range 7V- 35V
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 Current rating Ic = 1A

 Output voltage range V. Max=5.2V ,V. Min=4.8V

Figure 4.3: 5V Regulator IC

4.3 SWITCHMODE POWER SUPPLY

A switched-mode power supply (switching-mode power supply, switch-mode power

supply, switched power supply, SMPS, or switcher) is an electronic power supply that

incorporates a switching regulator to convert electrical power efficiently.

Figure 4.4: SMPS

https://en.wikipedia.org/wiki/Power_supply
https://en.wikipedia.org/wiki/Voltage_regulator
https://en.wikipedia.org/wiki/Electrical_power_conversion
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Unlike a linear power supply, the pass transistor of a switching-mode supply continually

switches between low-dissipation, full-on and full-off states, and spends very little time in

the high dissipation transitions, which minimizes wasted energy. A hypothetical ideal

switched-mode power supply dissipates no power. Voltage regulation is achieved by

varying the ratio of on-to-off time (also known as duty cycles). Switching regulators are

used as replacements for linear regulators when higher efficiency, smaller size or lighter

weight are required. They are, however, more complicated; their switching currents can

cause electrical noise problems if not carefully suppressed, and simple designs may have

a poor power factor. Switched-mode power supplies are classified according to the type

of input and output voltages. The four major categories are:

 AC to DC

 DC to DC

 DC to AC

 AC to AC

A basic isolated AC to DC switched-mode power supply consists of:

 Input rectifier and filter

 Inverter consisting of switching devices such as MOSFETs

 Transformer

 Output rectifier and filter

 Feedback and control circuit

The input DC supply from a rectifier or battery is fed to the inverter where it is turned on

and off at high frequencies of between 20 KHz and 200 KHz by the switching MOSFET

or power transistors. The high-frequency voltage pulses from the inverter are fed to the

transformer primary winding, and the secondary AC output is rectified and smoothed to

produce the required DC voltages. A feedback circuit monitors the output voltage and

instructs the control circuit to adjust the duty cycle to maintain the output at the desired

level.

https://en.wikipedia.org/wiki/Linear_power_supply
https://en.wikipedia.org/wiki/Dissipation
https://en.wikipedia.org/wiki/Voltage_regulator
https://en.wikipedia.org/wiki/Duty_cycle
https://en.wikipedia.org/wiki/Power_factor
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Figure 4.5: SMPS Circuit

Basic working concept of an SMPS

A switching regulator does the regulation in the SMPS. A series switching element turns

the current supply to a smoothing capacitor on and off. The voltage on the capacitor

controls the time the series element is turned. The continuous switching of the capacitor

maintains the voltage at the required level.

Design basics

AC power first passes through fuses and a line filter. Then it is rectified by a full-wave

bridge rectifier. The rectified voltage is next applied to the power factor correction (PFC)

pre-regulator followed by the downstream DC-DC converter(s). Most computers and

small appliances use the International Electro technical Commission (IEC) style input

connector. As for output connectors and pin outs, except for some industries, such as PC

and compact PCI, in general, they are not standardized and are left up to the manufacturer.

There are different circuit configurations known as topologies, each having unique

characteristics, advantages and modes of operation, which determines how the input

power is transferred to the output. Most of the commonly used topologies such as fly back,

push-pull, half bridge and full bridge, consist of a transformer to provide isolation,

https://www.electronicsforu.com/electronics-projects/power-factor-correction
https://www.iec.ch/about/?ref=menu
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voltage scaling, and multiple output voltages. The non-isolated configurations do not

have a transformer and the power conversion is provided by the inductive energy transfer.

Advantages of switched-mode power supplies:

 Higher efficiency of 68% to 90%

 Regulated and reliable outputs regardless of variations in input supply voltage

 Small size and lighter

 Flexible technology

 High power density

Disadvantages:

 Generates electromagnetic interference

 Complex circuit design

 Expensive compared to linear supplies

Switched-mode power supplies are used to power a wide variety of equipment such as

computers, sensitive electronics, battery-operated devices and other equipment requiring

high efficiency.

Switch Mode Power Supply

Figure 4.6: SMPS Circuit Connection
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Linear voltage IC regulators have been the basis of power supply designs for many years

as they are very good at supplying a continuous fixed voltage output.Linear voltage

regulators are generally much more efficient and easier to use than equivalent voltage

regulator circuits made from discrete components such a zener diode and a resistor, or

transistors and even op-amps. The most popular linear and fixed output voltage regulator

types are by far the positive output voltage series, and the negative output voltage series.

These two types of complementary voltage regulators produce a precise and stable

voltage output ranging from about 5 volts up to about 24 volts for use in many electronic

circuits.There is a wide range of these three-terminal fixed voltage regulators available

each with its own built-in voltage regulation and current limiting circuits. This allows us

to create a whole host of different power supply rails and outputs, either single or dual

supply, suitable for most electronic circuits and applications. There are even variable

voltage linear regulators available as well providing an output voltage which is

continually variable from just above zero to a few volts below its maximum voltage

output.

Most d.c. power supplies comprise of a large and heavy step-down mains transformer,

diode rectification, either full-wave or half-wave, a filter circuit to remove any ripple

content from the rectified d.c. producing a suitably smooth d.c. voltage, and some form of

voltage regulator or stabiliser circuit, either linear or switching to ensure the correct

regulation of the power supplies output voltage under varying load conditions. Then a

typical d.c. power supply would look something like this:

Typical DC Power Supply

These typical power supply designs contain a large mains transformer (which also

provides isolation between the input and output) and a dissipative series regulator circuit.
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The regulator circuit could consist of a single zener diode or a three-terminal linear series

regulator to produce the required output voltage. The advantage of a linear regulator is

that the power supply circuit only needs an input capacitor, output capacitor and some

feedback resistors to set the output voltage.

4.4 L293D Motor Driver IC

Figure 4.7: L293D

• L293D is a typical Motor driver or Motor Driver IC which allows DC motor to

drive on either direction. L293D is a 16-pin IC which can control a set of two DC

motors simultaneously in any direction. It means that you can control two DC

motor with a single L293D IC Dual H-bridge Motor Driver integrated circuit (IC).

• It works on the concept of H-bridge. H-bridge is a circuit which allows the

voltage to be flown in either direction. As you know voltage need to change its

direction for being able to rotate the motor in clockwise or anticlockwise direction,

hence H-bridge IC are ideal for driving a DC motor.

• In a single L293D chip there are two h-Bridge circuit inside the IC which can

rotate two dc motor independently. Due its size it is very much used in robotic

application for controlling DC motors. Given below is the pin diagram of a

L293D motor controller.

• There are two Enable pins on l293d. Pin 1 and pin 9, for being able to drive the

motor, the pin 1 and 9 need to be high. For driving the motor with left H-bridge
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you need to enable pin 1 to high. And for right H-Bridge you need to make the pin

9 to high. If anyone of the either pin1 or pin9 goes low then the motor in the

corresponding section will suspend working. It’s like a switch.

• There are 4 input pins for l293d, pin 2, 7 on the left and pin 15, 10 on the right as

shown on the pin diagram. Left input pins will regulate the rotation of motor

connected across left side and right input for motor on the right hand side. The

motors are rotated on the basis of the inputs provided across the input pins as

LOGIC 0 or LOGIC 1.

• In simple you need to provide Logic 0 or 1 across the input pins for rotating the

motor.

L293D Logic:

Let’s consider a Motor connected on left side output pins (pin 3, 6). For rotating the

motor in clockwise direction the input pins has to be provided with Logic 1 and Logic 0.

• Pin 2 = Logic 1 and Pin 7 = Logic 0 | Clockwise Direction

• Pin 2 = Logic 0 and Pin 7 = Logic 1 | Anticlockwise Direction

• Pin 2 = Logic 0 and Pin 7 = Logic 0 | Idle [No rotation] [Hi-Impedance state]

• Pin 2 = Logic 1 and Pin 7 = Logic 1 | Idle [No rotation]

In a very similar way the motor can also operate across input pin 15, 10 for motor on the

right hand side.

Figure 4.8: L293D circuit diagram
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4.5 Arduino Motor Driver
L293D is a monolithic integrated, high voltage, high current, 4-channel driver. Basically

this means using this chip you can use DC motors and power supplies of up to 16 Volts,

that’s some pretty big motors and the chip can supply a maximum current of 600mA per

channel, the L293D chip is also what's known as a type of H-Bridge. The H-Bridge is

typically an electrical circuit that enables a voltage to be applied across a load in either

direction to an output, e.g. motor.

Figure 4.9: L293D Motor Driver Shield

The L293D is quadruple high-current half-H drivers.It is designed to provide

bidirectional drive currents of up to 600-mA at voltages from 4.5 V to 36 V. Both devices

are designed to drive inductive loads such as relays, solenoids, dc and bipolar stepping

motors, as well as other high-current/high-voltage loads in positive-supply applications.

All inputs are TTL compatible. Each output is a complete totem-pole drive circuit, with a

Darlington transistor sink and a pseudo- Darlington source. Drivers are enabled in pairs,

with drivers 1 and 2 enabled by 1,2EN and drivers 3 and 4 enabled by 3,4EN. When an

enable input is high, the associated drivers are enabled, and their outputs are active and in

phase with their inputs. When the enable input is low, those drivers are disabled, and their

outputs are off and in the high-impedance state. With the proper data inputs, each pair of

drivers forms a full-H (or bridge) reversible drive suitable for solenoid or motor

applications.
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Figure 4.10: Logic Diagram

Pin Function:

Figure 4.11: IC Pin Out

Pin Name Function
1 Enable1,2 Enable pin to control 1,2 driver
2 Input 1A Input to control 1Y
3 Output 1Y Output, connect to motor
4 GND Ground and heat sink
5 GND Ground and heat sink
6 Output 2Y Output, connect to motor
7 Input 2A Input to control 2Y
8 Vcc2 Output supply voltage
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9 Enable3,4 Enable pin to control 3,4 driver
10 Input 3A Input to control 3Y
11 Output 3Y Output, connect to motor
12 GND Ground and heat sink
13 GND Ground and heat sink
14 Output 4Y Output, connect to motor
15 Input 4A Input to control 4Y
16 Vcc1 Supply voltage (7 max)

Table 1: IC Pin Out

Features

 Wide Supply-Voltage Range: 4.5 V to 36 V

 Separate Input-Logic Supply

 Internal ESD Protection

 Thermal Shutdown

 High-Noise-Immunity Inputs

 Output Current 600 mA Per Channel

 Peak Output Current 1.2 A Per Channel

4.6 DC Gear Motor
Description:

A DC motor is any motor within a class of electrical machines whereby direct current

electrical power is converted into mechanical power. ... A 12v DC motor is small and

inexpensive, yet powerful enough to be used for many applications.

Specification:

 Voltage: 12V DC

 Gear ratio: 1/31

 No-load speed: 200RPM

 Rated Speed: 140RPM
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 Rated torque: 10kg.cm

 Rated current: 2.5Amp

 Length of Motor(including spindle): 106mm/4.17″

 Diameter: 37mm/1.45″

 Shaft length: 21mm/0.82″

 Shaft diameter: 6mm/0.24″

Figure 4.12: DC Gear Motor

4.7 Motor Pulley

A pulley is a wheel on an axle or shaft that is designed to support movement and change

of direction of a taut cable or belt, or transfer of power between the shaft and cable or belt.

In the case of a pulley supported by a frame or shell that does not transfer power to a shaft,

but is used to guide the cable or exert a force, the supporting shell is called a block, and

the pulley may be called a sheave.A pulley may have a groove or grooves

between flanges around its circumference to locate the cable or belt. The drive element of

a pulley system can be a rope, cable, belt, or chain. The earliest evidence of pulleys dates

back to Ancient Egypt in the Twelfth Dynasty (1991-1802 BCE) and Mesopotamia in the

early 2nd millennium BCE. In Roman Egypt, Hero of Alexandria (c. 10-70 CE) identified

the pulley as one of six simple machines used to lift weights. Pulleys are assembled to

form a block and tackle in order to provide mechanical advantage to apply large forces.

Pulleys are also assembled as part of belt and chain drives in order to transmit power from

https://en.wikipedia.org/wiki/Wheel
https://en.wikipedia.org/wiki/Axle
https://en.wikipedia.org/wiki/Shaft_(mechanical_engineering)
https://en.wikipedia.org/wiki/Groove_(machining)
https://en.wikipedia.org/wiki/Flange
https://en.wikipedia.org/wiki/Circumference
https://en.wikipedia.org/wiki/Rope
https://en.wikipedia.org/wiki/Wire_rope
https://en.wikipedia.org/wiki/Belt_(mechanical)
https://en.wikipedia.org/wiki/Chain
https://en.wikipedia.org/wiki/Ancient_Egypt
https://en.wikipedia.org/wiki/Twelfth_Dynasty_of_Egypt
https://en.wikipedia.org/wiki/Mesopotamia
https://en.wikipedia.org/wiki/Roman_Egypt
https://en.wikipedia.org/wiki/Hero_of_Alexandria
https://en.wikipedia.org/wiki/Simple_machines
https://en.wikipedia.org/wiki/Block_and_tackle
https://en.wikipedia.org/wiki/Mechanical_advantage
https://en.wikipedia.org/wiki/Belt_(mechanical)
https://en.wikipedia.org/wiki/Chain_drive
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one rotating shaft to another. Plutarch's Parallel Lives recounts a scene

where Archimedes proved the effectiveness of compound pulleys and the block-and-

tackle system by using one to pull a fully laden ship towards him as if it was gliding

through water.

Figure 4.13: Pulley

4.8 Rain sensor
A rain sensor is one kind of low-cost electronic sensor which is used to detect the rainfall or

water drops. It works as a switch. Normally the switch is open condition. This sensor is

consists of mainly two parts, one is Sensing Pad and another one is the Sensor Module.

When rainfall or water drops fall on the Sensing Pad surface, then the switch will be closed.

Figure 4.14: Rain Sensor Pin Diagram

https://en.wikipedia.org/wiki/Plutarch
https://en.wikipedia.org/wiki/Parallel_Lives
https://en.wikipedia.org/wiki/Archimedes
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The Sensor Module reads data from the sensor pad and processes the data and converts it

into a digital/analog output. So, the sensor can provide both types of output Digital output

(DO) and Analog output(AO). The Rain Sensor Module’s Sensing Pad consists of two

nickel-coated series copper tracks. Also, it has two Header pins, these are internally

connected to the two copper tracks of the Sensing Pad. These pins are used to connect the

Sensing Pad to the rain sensor module circuit through two jumper wire. Always, one pin

of the rain sensor circuit provides a +5v power supply to the one track of the sensing pad,

and another pin is received the return power supply from another track of the sensing pad.

Normally under dry conditions, the sensing pad provides high resistance and low

conductive. So, the 5v power supply cannot be passed from one track to another track. Its

resistance varies according to the amount of water on the surface of the sensing pad.

When water drops fall on the sensor pad surface its resistance will decrease and

conductivity will increase. So, when water drops increase on the pad surface it can pass

more power supply through one track to another track.

Figure 4.15: Rain Sensor Pin Indication & Description

Figure 02 : Rain sensor Pin Description

Pin NoPin Name Description

1 VCC +5 v power supply

2 GND Ground (-) power supply
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Sensor Module Hardware Overview

The Sensor module is consists of some key components. These are LM393 Comparators,

Variable Resistor (Trimpot), Power LED, output LED.

Rain Sensor Specifications

Table 03: Rain Sensor Specialization

Parameter Value

Operating Voltage 3.3V – 5V

Operating Current 15 mA

Comparator chip LM393

Sensitivity Adjustable via Trimpot

Output type Analog output voltage (AO) and Digital switching
voltage (DO)

LED lights indicators Power (red/green) and Output (red/green)

Sensing pad 5cm x 4 cm nickel plate on one side.

Module PCB Size 3.2cm x 1.4cm

Application

 Rainfall detection

 It’s used in an irrigation system, when rainfall is started it shut down the watering

system automatically.

3 DO Digital Output (0 or 1)

4 AO Analog Output (range 0 to 1023)

https://www.electroduino.com/lm393-comparator-ic-pinout-specifications-working-principle/
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4.9 BEARING

A bearing is a machine element that constrains relative motion to only the desired motion,

and reduces friction between moving parts. The design of the bearing may, for example,

provide for free linear movement of the moving part or for free rotation around a fixed

axis; or, it may prevent a motion by controlling the vectors of normal forces that bear on

the moving parts. Most bearings facilitate the desired motion by minimizing friction.

Bearings are classified broadly according to the type of operation, the motions allowed, or

to the directions of the loads (forces) applied to the parts. Rotary bearings hold rotating

components such as shafts or axles within mechanical systems, and transfer axial and

radial loads from the source of the load to the structure supporting it. The simplest form

of bearing, the plain bearing, consists of a shaft rotating in a hole. Lubrication is used to

reduce friction. In the ball bearing and roller bearing, to reduce sliding friction, rolling

elements such as rollers or balls with a circular cross-section are located between the

races or journals of the bearing assembly. A wide variety of bearing designs exists to

allow the demands of the application to be correctly met for maximum efficiency,

reliability, durability and performance.

Figure4.16: Bearing

https://en.wikipedia.org/wiki/Machine_element
https://en.wikipedia.org/wiki/Friction
https://en.wikipedia.org/wiki/Moving_parts
https://en.wikipedia.org/wiki/Line_(geometry)
https://en.wikipedia.org/wiki/Rotation_around_a_fixed_axis
https://en.wikipedia.org/wiki/Rotation_around_a_fixed_axis
https://en.wikipedia.org/wiki/Vector_(mathematics_and_physics)
https://en.wikipedia.org/wiki/Normal_force
https://en.wikipedia.org/wiki/Shaft_(mechanical_engineering)
https://en.wikipedia.org/wiki/Axle
https://en.wikipedia.org/wiki/Plain_bearing
https://en.wikipedia.org/wiki/Lubrication
https://en.wikipedia.org/wiki/Ball_bearing
https://en.wikipedia.org/wiki/Roller_bearing
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4.10 CAPACITOR

When there is a potential difference across the conductors (e.g., when a capacitor is

attached across a battery), an electric field develops across the dielectric, causing positive

charge (+Q) to collect on one plate and negative charge (-Q) to collect on the other plate.

If a battery has been attached to a capacitor for a sufficient amount of time, no current can

flow through the capacitor. However, if an accelerating or alternating voltage is applied

across the leads of the capacitor, a displacement current can flow.

Figure 4.17: Capacitor

An ideal capacitor is characterized by a single constant value for its capacitance.

Capacitance is expressed as the ratio of the electric charge (Q) on each conductor to the

potential Difference (V). The SI unit of capacitance is the farad (F), which is equal to one

coulomb per volt (1 C/V). Typical capacitance values range from about 1 pF (10−12 F) to

about 1 mF (10−3 F). The capacitance is greater when there is a narrower separation

between conductors and when the conductors have a larger surface area. In practice, the

dielectric between the plates passes a small amount of leakage current and also has an

electric field strength limit, known as the breakdown voltage. The conductors and leads

introduce an undesired inductance and resistance. Capacitors are widely used in electronic

circuits for blocking direct current while allowing alternating current to pass. In analog

filter networks, they smooth the output of power supplies. In resonant circuits they tune

radios to particular frequencies. In electric power transmission systems, they stabilize

voltage and power flow.

The full-wave bridge rectifier however, gives us a greater mean DC value (0.637 Vmax)

with less superimposed ripple while the output waveform is twice that of the frequency of

the input supply frequency. We can improve the average DC output of the rectifier while
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at the same time reducing the AC variation of the rectified output by using smoothing

capacitors to filter the output waveform. Smoothing or reservoir capacitors connected in

parallel with the load across the output of the full wave bridge rectifier circuit increases

the average DC output level even higher as the capacitor acts like a storage device as

shown below. Too low a capacitance value and the capacitor has little effect on the output

waveform. But if the smoothing capacitor is sufficiently large enough (parallel capacitors

can be used) and the load current is not too large, the output voltage will be almost as

smooth as pure DC.

Figure 4.18: The Smoothing Capacitor with Full Bridge Rectifier

4.11 RESISTOR

A resistor is a passive two-terminal electrical component that implements electrical

resistance as a circuit element. Resistors act to reduce current flow, and, at the sometime,

act to lower voltage levels within circuits. Resistors may have fixed resistances or

variable resistances, such as those founding thermostats, visitors, trimmers, photo

resistors, hamsters and potentiometers. The current through a resistor is in direct

proportion to the voltage across the resistor's terminals. This relationship is represented

by Ohm's law.
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Figure 4.19: Resistor

Theory of operation:

The behavior of an ideal resistor is dictated by the relationship specified by Ohm ‘slaw:

V = I.R

Ohm's law states that the voltage (V) across a resistor is proportional to the current (I),

where the constant of proportionality is the resistance (R).

Equivalently, Ohm's law can be stated:

I = V/R

This formulation states that the current (I) is proportional to the voltage (V) and inversely

proportional to the resistance (R). This is directly used in practical computations. For

example, if a 300 ohm resistor is attached across the terminals of a12 volt battery, then a

current of12 / 300 = 0.04 amperes flows through that resistor.

4.12 Arduino IDE

The digital microcontroller unit named as Arduino Nano can be programmed with the

Arduino software IDE. There is no any requirement for installing other software rather

than Arduino. Firstly, Select "Arduino Nano from the Tools, Board menu (according to

the microcontroller on our board). The IC used named as ATmega328 on the Arduino

Nano comes pre burned with a boot loader that allows us to upload new code to it without

the use of an external hardware programmer.

Communication is using the original STK500 protocol (reference, C header files). We can

also bypass the boot loader and programs the microcontroller through the ICSP (In Circuit

Serial Programming) header. The ATmega16U2 (or 8U2 in the rev1 and rev2 boards)

firmware source code is available. The ATmega16U2/8U2 is loaded with a DFU boot
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loader, which can be activated by:

On Rev1 boards: connecting the solder jumper on the back of the board (near the map of

Italy) and then resetting the 8U2. On Rev2 or later boards: there is a resistor that pulling

the 8U2/16U2 HWB line to ground, making it easier to put into DFU mode.

The Arduino Nano is one of the latest digital microcontroller units and has a number of

facilities for communicating with a computer, another Arduino, or other microcontrollers.

The ATmega328 provides UART TTL at (5V) with serial communication, which is

available on digital pins 0 -(RX) for receive the data and pin no.1 (TX) for transmit the

data. An ATmega16U2 on the board channels this serial communication over USB and

appears as a virtual com port to software on the computer. The '16U2 firmware uses the

standard USB COM drivers, and no external driver is needed. However, on Windows,

an .in file is required. The Arduino software includes a serial monitor which allows

simple textual data to be sent to and from the Arduino board.

Figure 4.20: Arduino Software Interface IDE

The RX and TX LEDs on the board will flash when data is being transmitted via the

USB-to-serial chip and USB connection to the computer (but not for serial
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Communication on pins 0 and 1). A Software Serial library allows for serial

communication on any of the Nano's digital pins. The ATmega328 also supports I2C

(TWI) and SPI communication. The Arduino software includes a Wire library to simplify

use of the I2C bus. Arduino programs are written in C or C++ and the program code

written for Arduino is called sketch. The Arduino IDE uses the GNU tool chain and AVR

Lab to compile programs, and for uploading the programs it uses argued. As the Arduino

platform uses Atmel micro-controllers, Atmel's development environment, AVR Studio

or the newer Atmel Studio, may also be used to develop software for the Arduino. The

Arduino Integrated Development Environment - or Arduino Software (IDE) - contains a

text editor for writing code, a message area, a text console, a toolbar with buttons for

common functions and a series of menus. It connects to the Arduino and Genuino

hardware to upload programs and communicate with them.

Writing Sketches

Programs written using Arduino Software (IDE) are called sketches. These sketches are

written in the text editor and are saved with the file extension .ino. The editor has features

for cutting/pasting and for searching/replacing text. The message area gives feedback

while saving and exporting and also displays errors. The console displays text output by

the Arduino Software (IDE), including complete error messages and other information.

The bottom right hand corner of the window displays the configured board and serial port.

The toolbar buttons allow you to verify and upload programs, create, open, and save

sketches, and open the serial monitor.

Sketchbook

The Arduino Software (IDE) uses the concept of a sketchbook: a standard place to store

your programs (or sketches). The sketches in your sketchbook can be opened from the

File > Sketchbook menu or from the Open button on the toolbar. The first time you run

the Arduino software, it will automatically create a directory for your sketchbook. You

can view or change the location of the sketchbook location from with the Preferences

dialog. Beginning with version 1.0, files are saved with a .ino file extension. Previous

versions use the .pde extension. You may still open .pde named files in version 1.0 and

later, the software will automatically rename the extension to .ino.

Tabs, Multiple Files, and Compilation
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Allows you to manage sketches with more than one file (each of which appears in its own

tab). These can be normal Arduino code files (no visible extension), C files (.c extension),

C++ files (.cpp), or header files (.h).

Uploading

Before uploading your sketch, you need to select the correct items from the Tools > Board

and Tools > Port menus. The boards are described below. On the Mac, the serial port is

probably something like /dev/tty.usbmodem241 (for a Uno or Mega2560 or Leonardo) or

/dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or

/dev/tty.USA19QW1b1P1.1 (for a serial board connected with a Keyspan USB-to-Serial

adapter). On Windows, it's probably COM1 or COM2 (for a serial board) or COM4,

COM5, COM7, or higher (for a USB board) - to find out, you look for USB serial device

in the ports section of the Windows Device Manager. On Linux, it should be

/dev/ttyACMx , /dev/ttyUSBx or similar. Once you've selected the correct serial port and

board, press the upload button in the toolbar or select the Upload item from the Sketch

menu. Current Arduino boards will reset automatically and begin the upload. With older

boards (pre-Diecimila) that lack auto-reset, you'll need to press the reset button on the

board just before starting the upload. On most boards, you'll see the RX and TX LEDs

blink as the sketch is uploaded. The Arduino Software (IDE) will display a message when

the upload is complete, or show an error.

When you upload a sketch, you're using the Arduino Bootloader, a small program that has

been loaded on to the microcontroller on your board. It allows you to upload code without

using any additional hardware. The Bootloader is active for a few seconds when the board

resets; then it starts whichever sketch was most recently uploaded to the microcontroller.

The Bootloader will blink the on-board (pin 13) LED when it starts (i.e. when the board

resets).

Libraries

Libraries provide extra functionality for use in sketches, e.g. working with hardware or

manipulating data. To use a library in a sketch, select it from the Sketch > Import Library

menu. This will insert one or more #include statements at the top of the sketch and

compile the library with your sketch. Because libraries are uploaded to the board with

your sketch, they increase the amount of space it takes up. If a sketch no longer needs a
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library, simply delete its #include statements from the top of your code. There is a list of

libraries in the reference. Some libraries are included with the Arduino software. Others

can be downloaded from a variety of sources or through the Library Manager. Starting

with version 1.0.5 of the IDE, you do can import a library from a zip file and use it in an

open sketch. See these instructions for installing a third-party library.

Third-Party Hardware

Support for third-party hardware can be added to the hardware directory of your

sketchbook directory. Platforms installed there may include board definitions (which

appear in the board menu), core libraries, Bootloaders, and programmer definitions. To

install, create the hardware directory, then unzip the third-party platform into its own sub-

directory. (Don't use "Arduino" as the sub-directory name or you'll override the built-in

Arduino platform.) To uninstall, simply delete its directory. For details on creating

packages for third-party hardware, see the Arduino IDE 1.5 3rd party Hardware

specification.

Serial Monitor

This displays serial sent from the Arduino or Genuino board over USB or serial connector.

To send data to the board, enter text and click on the "send" button or press enter. Choose

the baud rate from the drop-down menu that matches the rate passed to Serial begin in

your sketch. Note that on Windows, Mac or Linux the board will reset (it will rerun your

sketch) when you connect with the serial monitor.

4.13 Proteus Software
The Proteus Design Suite is a proprietary software tool suite used primarily for electronic

design automation. The software is used mainly by electronics design engineers and

technicians to create schematics and electronics prints for manufacturing printed circuit

boards. The first version of what is now the Proteus Design Suite was called PC-B and

was written by the company chairman, John Jameson, for DOS in 1988. Schematic

Capture support followed in 1990 with a port to the Windows environment shortly

thereafter. Mixed mode SPICE Simulation was first integrated into Proteus in 1996 and

microcontroller simulation then arrived in Proteus in 1998. Shape based auto routing was
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added in 2002 and 2006 saw another major product update with 3D Board Visualization.

More recently, a dedicated IDE for simulation was added in 2011 and MCAD

import/export was included in 2015. Support for high speed design was added in 2017.

Feature led product releases are typically biannual, while maintenance-based service

packs are released as required.

Figure 4.21: Proteus Software Interface
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CHAPTER 5

METHODOLOGY

5.1 Methodology
 Creating an idea for Design and Fabrication of Automatic Rain Shade for

Different Ambient Conditions. And drawing and listed of

components/materials to know which components/materials need to construct

it.

 Collecting the all components/materials for construct the system.

 Finally, we constructed this system & checked it finally that working very

well.

5.2 Complete Project Prototype Image :

Figure 5.1: Complete Project Picture
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5.3 Working Principle

The main brain of our system is the Arduino Pro Mini. The way of whole project works is

that we take 220V (rms) AC power from the supply voltage and then feed it to a Switch

Mode Power Supply or in short SMPS module. The SMPS simply converts the 220V AC

to a pure DC of 5V. We will use this 5V DC output from the SMPS to run our micro-

controller, sensor and other units.

Here we use arduino pro mini, smps, rain sensor, gear motor, bearing motor pully and

pully belt. Our project main work is provide automatic rain shed. In rain sensor detect

water then the system will get a signal by the rain sensor and send it to the controller.

Micro controller send a signal to motor driver IC. Then motor driver drive the gear motor

at a certain speed and fold or expand of the shed. And provide a protection from rain. It

also work in manually. It is the main purpose of this system.
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CHAPTER 6

RESULT AND DISCUSSION

6.1 Discussion
In this project we added all of this equipment and setup it properly. Then observe our

system. In the very beginning time, we can’t do it properly, after a great teamwork we solve

our problem and finally able to measure water level, water temperature and weather

condition like rain and end notification in our phone, After using this system we really know

our pond condition.

6.2 Result
Now, it’s time to talk about the results. We have written our commands using the Arduino

IDE and the following things can happen:

 When this project is run then it will sense the rain on the rain sensor then the shed

will fold or extend automatically.

 It is also operate it manually.


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Figure 6.1: Our System in Full Open Position

Figure 6.2: Our System in Half Fold Position

Figure 6.3: Our System in Full Fold Position



37

6.3 Advantage

• Automatic Rain protection System

• Automatic and Manual Control

• Time saving machine for industrial work.

• No Oil consumption.

• Time saving equipment.

• Installation is simplified very much.

• Simple construction

• Ease of operation.

6.4 Application
The project has a major application in the

• It can be used for Industrial work.

• It can be used in football field

• It can be use rooftop garden

6.5 Limitation
It is a demo project so we found some limitation. In future we will work for reduce this

kind of limitation. These limitations are –

 It is a demo project so it has some error.

 Our project may delay in work.
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CHAPTER 7

CONCLUSION

7.1 Conclusion
This is real time model which is used to automatic rain water and crop saving system

protects crops from excess amount of rain water and also saves water from wastage. By

using Arduino operations of the entire system is going to be controlled these system saves

the electricity, maximizes the productivity during both rainy season and sunny season.

Controlling of system on users virtue can also be achieved through device like rain sensor.

hardware implementation are reliable and cheap of this project.

7.2 Future Scope
The model can be improved by making some changes in the program and components.

Some suggestions are given below-

• We will increase its working accuracy level.

• We will think about adding leaser cutting and PCB Design.



39

Reference:

[1] Carlisle, R. P. (2004). Scientific American inventions and discoveriees: all the

milestones in ingenuityfrom the discovery of fire to the invention of the

microwave oven. said.

[2] Day, S. T. (1985). U.S. Patent No. 4,534,374. Washington, DC: U.S. Patent and

Trademark Office.

[3] Engst, C., Chhokar, R., Miller, A., Tate, R. B., & Yassi, A. (2005). Effectiveness

of overhead lifting devices in reducing the risk of injury to care staff in extended

care facilities. Ergonomics, 48(2), 187-199.

[4] Gingerich, B. S., & Ondeck, D. A. (1998). Pocket guide for the home care aide.

Jones & Bartlett Learning.

[5] Hui, L., Ng, G. Y., Yeung, S. S., & Hui-Chan, C. W. (2001). Evaluation of

physiological work demands and low back neuromuscular fatigue on nurses

working in geriatric wards. Applied ergonomics, 32(5), 479-483.

[6] Li, W. Y. (2011). U.S. Patent No. 8,061,374. Washington, DC: U.S. Patent and

Trademark Office.

[7] Martinec, A. E. C. (2011). U.S. Patent No. 7,909,048. Washington, DC: U.S.

Patent and Trademark Office.

[8] Meng, S. H., Huang, A. C., Lee, C. J., Huang, T. J., & Dal, J. N. (2017,

November). Design for intelligent control system of curtain based on Arduino. In

International Conference on Smart Vehicular Technology, Transportation,

Communication and Applications (pp. 178-184). Springer, Cham.

[9] Nelson, A., Matz, M., Chen, F., Siddharthan, K., Lloyd, J., & Fragala, G. (2006).

Development and evaluation of a multifaceted ergonomics program to prevent

injuries associated with patient handling tasks. International journal of nursing

studies, 43(6), 717-733.



40

[10] OHSAH. (2004). Memorandum of understanding with regards to manual patient

handling between the association of unions and health employers association of

British Columbia. Vancouver. B.Occupational Health and Safety Agency for

Healthcare in British Columbia, British Colombia.

[11] Portis Jr, M. N., & Hampton, O. (2013). U.S. Patent No. 8,497,656. Washington,

DC: U.S. Patent and Trademark Office.

[12] Smith-Temple, J., & Johnson, J. Y. (2005). Nurses' guide to clinical procedures.



41

Appendix

int for_button = 2;

int rev_button = 3;

int motor1 = 4;

int motor2 = 5;

int rain = 6;

int rainn;

int limit1 = 7;

int limit2 = 8;

void setup() {

Serial.begin(9600);

pinMode(for_button,INPUT);

pinMode(rev_button,INPUT);

pinMode(rain,INPUT);

pinMode(limit1,INPUT);

pinMode(limit2,INPUT);

pinMode(motor1,OUTPUT);

pinMode(motor2,OUTPUT);

digitalWrite(motor1,LOW);

digitalWrite(motor2,LOW);

}

void loop() {

int forward = digitalRead(for_button);

int reverse = digitalRead(rev_button);

int forward_limit = digitalRead(limit1);

int reverse_limit = digitalRead(limit2);
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rainn = digitalRead(rain);

Serial.print("forward: ");

Serial.println(forward);

Serial.print("reverse: ");

Serial.println(reverse);

Serial.print("forward_limit: ");

Serial.println(forward_limit);

Serial.print("reverse_limit: ");

Serial.println(reverse_limit);

Serial.println(rainn);

if(reverse == HIGH ){

digitalWrite(motor1,LOW);

digitalWrite(motor2,HIGH);

}

if(rainn == HIGH ){

digitalWrite(motor1,HIGH);

digitalWrite(motor2,LOW);

}

if(rainn == HIGH && reverse_limit == HIGH ){

digitalWrite(motor1,LOW);

digitalWrite(motor2,LOW);

}

if(rainn == LOW){

digitalWrite(motor1,LOW);

digitalWrite(motor2,HIGH);

}
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if(rainn == LOW && forward_limit == HIGH){

digitalWrite(motor1,LOW);

digitalWrite(motor2,LOW);

}

if(forward == HIGH ){

digitalWrite(motor1,LOW);

digitalWrite(motor2,HIGH);

}

if(forward == HIGH && forward_limit == HIGH){

digitalWrite(motor1,LOW);

digitalWrite(motor2,LOW);

}

if(reverse == HIGH ){

digitalWrite(motor1,HIGH);

digitalWrite(motor2,LOW);

}

if(reverse == HIGH && reverse_limit == HIGH){

digitalWrite(motor1,LOW);

digitalWrite(motor2,LOW);

}

delay(100);

}
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